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The Inside Editor is the default editing environment in Roxen CMS. In this editor, you can enter and edit your content,
customize your menus, and add metadata, such as the title displayed in the menu, keywords, and a page description.
Tabs for metadata and
properties

Buttons for authoring,
editing, and publishing
content

Buttons for opening
SiteBuilder and
exiting edit mode
List of
unpublished pages
in sidebar

The Delete button deletes the displayed page. If you have never published the page, it is permanently deleted. If the page has
been published, you will be able to revert to an undeleted version. Details about using the other features are included in other
sections of this document and the Roxen CMS Basics quick reference card.
When you click the CE button, the SiteBuilder editor opens in
the Files tab, showing the data for the page you were on.
This tab is where you can manage your files and folders.
To show the contents of
higher-level folders, click the
folder in the breadcrumbs
Navigation
buttons

You can find
documentation, on the
Docs tab

The
current
publishing
status of
the file

Buttons for
editing, file
management
and version
control

The publishing status of the current file is displayed next to
the file or folder name.
This icon in the
You column
indicates that
you have changes
that have not
been committed

The Site column shows this icon if
there is a previously published or
committed version of the
file
The page icon with the arrow
provides a drop-down menu
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The page icon with an arrow next to the file name provides a
drop-down menu of the functions you can select for this file.
These functions include copying, moving or renaming, and
deleting the file; editing the contents of the file or its
metadata; viewing the source, the change log, and
differences between this version and another version of the
file; and discarding or commtting changes.
To look for other files, or to view contents of a folder, you can
click the folder name in the breadcrumbs.

The buttons down the side of the Files tab in SiteBuilder
(CE), provide menus of functions you can perform. The
functions that are available in each menu depend on the
selected item and its status.
The File menu includes:
 Create or upload a new file, or create a
new directory (folder)
 Copy, move or rename, delete, or
undelete a file
 Export or import a file, or empty trash
The Edit menu includes:
 Edit, upload, or check the contents of a
file
 Edit metadata, category, visibility, or
email notification for a file
 Customize the template
 Edit permissions
Note: The Edit menu is dimmed if you have
not selected a file.
The View menu includes:
 View, and view source
 View differences, contributors, editing
status, and cache dependencies
 View the change log

This is the normal view. You can also display only changes
To display contents
of a folder, click the
plus icon

The publishing
status is
displayed for
each file
You can also display the contents of all the
displayed folders at once by clicking the
Unfold Level button on the top right. To
return to the default view, click the Fold All button.

The Versions menu includes:
 Discard changes
 Update
 Commit

Other useful tabs in SiteBuilder (CE)
Using the Access Control tab is described in “Securing
Pages and Folders”.
The Configuration tab is where you can customize your user
interface, editor settings, etc, and download the Application
Launcher (if you need to edit files locally, outside of Roxen).
The Docs tab is where you can find Roxen documentation.
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e)
f)

If you need to copy many files, or even complete folders of
files from an old web site, you can use a tool called WebDAV
to drag and drop files and folders into your Roxen site. See
www.princeton.edu/roxen/documentation/webdav for details.

g)

On the Commit page, uncheck any files you don’t
want to commit, and click the Next button.
Type a brief explanation in the Enter a log message
field, and click OK.
To return to the Insite Editor (your normal view),
click the Insite Editor
button.

To use WebDAV in Windows Vista:

To link to the files:

1.

Map your Roxen edit site as a network drive:
a) On your desktop, double-click Computer, and then
click Map Network Drive.
b) Click Connect to a Web site that you can use to
store your documents and pictures.
c) Click Next, and then Choose a custom network
location. Click Next again.
d) In the Internet or network address field, enter your
Roxen edit site’s URL. If you are on dept-edit, enter
https://www-dept-edit.princeton.edu:1443/main/
siteID, where siteID is your site folder. Click Next.
e) When prompted, enter your NetID, making sure
you remove any prefixes like Princeton\ or
www-dept-edit.princeton.edu\.
f) Enter your password and click OK.
g) When you have logged in, you will be prompted for
a name. You can leave the default, or enter a name
that will be easy to recognize.
h) Click Next, and then Finish.

1.

Open the page where you want to put the link(s) and
click the Edit button.

2.

To link using the File component, follow the instructions
under “Uploading and Linking to PDF Files” on the
Creating a Roxen Web Site quick reference card.

Drag and drop the files and folders you need from your
computer to your Roxen folder, or use Copy and Paste.

Creating Tables in Roxen

Tip! It will be easier to find the files later if you put
them in the folders you have already created in Roxen.

The preferred method of creating tables is the Table feature
in the Text and Picture component. The Table component is
not recommended at this time.

2.

3.

Commit the files in your edit site:
a)
b)
c)

Enter edit mode in Roxen.
Click the CE button (top toolbar, on the right).
In the breadcrumbs at the top of the Files tab, click
the folder where you uploaded the files.

Click the
folder name
d)

Click the Versions button on the left, and select
Commit in the drop-down menu.
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If you copied the file to the folder that contains the
page, the files will be listed in the File Browser
window.
If you copied the file to a different folder, use the
navigation breadcrumbs to navigate to the
appropriate folder.

To link to text in a text and picture component, follow the
instructions “To link to the file” under “Uploading Files in
CE” on the Roxen CMS Basics quick reference.
Note: When linking in a text and picture component,
you will need to know the name and path to the file.
You will not be able to navigate to and select the file.

To create a table in the Text and Picture
component:
1.

In the Text and Picture component, position your cursor
where you want the table to appear and click the Insert/
Edit Table
button in the first toolbar.
Insert/Edit Table
button

2.

In the Table Properties window, enter



the number of Rows and Columns
the Border size in pixels (1 is usually sufficient)

Tip! If your site’s theme sets a table border, that
setting may override anything set here.









3.

the Alignment of the table
table Width and Height, if desired (For example, if
you want the table to be 75% of the width of the
component, specify a Width of 75 and select
percent from the drop-down.)
Cell spacing (the number of pixels between cell
borders)
Cell padding (the number of pixels between the cell
contents and the cell border—between 4 and 8
pixels usually provides a comfortable distance)
a Caption to be displayed under the table
a Summary of the table for accessibility programs

Click OK. The table is displayed in the Text and Picture
component.

Tip! If you need to change table properties later, click
the table, and then click the Insert/Edit Table button.
4.

Enter the text in the table cells, formatting as desired.

5.

If you need to add another row, right click on the row,
select Row from the shortcut menu, and select Insert
Row Before or Insert Row After.

6.

To add another column, right click on the column, select
Column, and then select Insert Column Before or
Insert Column After.

7.

To delete a row or column, right click in the row or
column you want to delete, and select Row or Column,
and then select Delete Rows or Delete Columns.

8.

To merge cells, select the cells you want to merge, right
click, and select Cell, Merge Cells.

9.

To split cells, right click on the cell, and select Cell, Split
cell Horizontally or Split Cell Veritcally.

10. To control column width, click a cell in the column to
place the cursor, then right-click that cell. Select Cell,
Cell Properties. Set the width in either pixels or a
percentage of the table, and click OK.
11. When you have entered all your text, save the
component, or save the page if you are finished.
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Most changes to the menu are made on the Properties tab.
Properties tab

4.

If you want to open the link in a new window, select
Open link in new window in the Target Window field.

c)
d)

5.

Save the component or, if you are finished, save the
menu.

e)

Menu button

To hide a menu item:

To change the sequence of menu items:
1.

Click the Properties tab, and then click the Menu button.

2.

Click the Insert tag above the Menu Remaining tag.

1.

On the Menu page, click the tag for the Menu Entry you
want to hide.

2.

Uncheck the Show this item checkbox.

3.

Save the component or, if you are finished, save the
menu.

3.

Select the Entry you want to list first in the menu.

To rename a page in the menu:

4.

Repeat Step 3 for each entry that you want to appear in
the menu.

1.

On the page associated with the item you want to
change, click the Metatdata tab, then the Title button.

5.

To move a menu item up or down in the menu, click the
appropriate arrow before the Menu Entry tag for that
item
until the item is where you want it.

2.

Type the new name in the Title field and click OK.

6.

button to save the component and
Click the Save
continue working on the menu, or click the Save Menu
button to exit the menu editor.

To add separator text:
1.

On the Menu page, click the Insert tag where you want
to insert the separator, and select Menu Divider.

2.

In the Label field, type the text you want to use as a
separator or heading in the menu.

3.

Save the component or, if you are finished, save the
menu.

To add an outside link in a menu:

Note: This may not work for non-standard site themes.
Customizing the banner photo requires you to edit your
custom.css file. If you don’t already have such a file, you
may need to create both the css folder, and the custom.css
file. You will also need to create an images subfolder to hold
your custom banner image(s).

1.

Navigate to the custom.css file. If you don’t already
have one, you will need to create one in the css folder,
using File, Create New File.

2.

Click the page with the arrow
next to the
custom.css file name, and select Edit Contents.

3.

Enter the following text:
#bannerphoto {
background-image: url(imagepath/image.jpg);
height: nnnpx;
}
where imagepath is the path to your image folder (ending
with the folder name), image is the name of your file,
and nnn is the height of the file in pixels.

4.

Save the file, and commit the changes.

To use custom images on a group of pages:
1.

Navigate to the custom.css file. If you don’t already
have one, you will need to create one in the css folder,
using File, Create New File.

2.

Click the page with the arrow
next to the
custom.css file name, and select Edit Contents.

3.

Enter the following text:
#pagename #bannerphoto {
background-image: url(imagepath/image.jpg);
height: nnnpx; }
where pagename is the name of the folder that contains
the page(s) where you want the image, imagepath is the
path to the folder that contains your image, image is the
name of your file, and nnn is the height of the file in
pixels. Pages in all subfolders will also use this image.

4.

Save the file, and commit the changes.

To upload your banner image(s):
1.

Make sure your images are the correct size. Make a
note of the dimensions in pixels.

2.

Open your website and click the CE button.

1.

On the Menu page, click the Insert tag where you want
to insert the link, and select Menu Link.

2.

In the Title field, type the text you want to appear in the
menu.

3.

If you don’t already have a css/images folder, create
one using File, Create Directory in CE.

3.

If you know the URL, type it in the Link URL field,
including the http:// at the beginning of the URL. You
can also copy the URL from your browser and paste it
here.

4.

In the css/images folder, upload your image file using
File, Upload New File:
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To use your custom banner image on all pages:

Customizing the Banner Image
You can change the default banner photo for your entire site,
or for specific pages and groups of pages in the site.

a)
b)

Use the Browse button to locate your image file.
Click Next, verify the file name and click Next again.

Verify the image type and click OK.
Click the page icon with the down arrow
next to
the image file, and select Commit from the menu.
Enter a brief explanation and click OK.

Note: For additional customization instructions, see
www.princeton.edu/roxen/documentation/changing-atheme-banner.
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Enter search
criteria
Scroll, if
necessary, and
click to select
the group

You may need to hide a page on your public site while you
are developing it or until a specific date, or you may need to
hide a page from everyone except a specific audience.

To hide a page until a specific date:
1.
2.

Click the Visibility

3.

Select when the page should be visible to external
viewers.

4.

If you select Visible until a specified time, Visible
after a specified time, or Visible during a specified
time interval, a calendar is displayed where you can
select the date.

b)
c)

button.

Use the arrows at the top of the calendar to scroll
through the months as needed.
Click on the day to select the day of the month.
Select the hour (1-24) and minute when the page
should be visible.

5.

Click the OK button.

6.

Click the Main tab to return to the standard edit view.

8.

Click the group you want, and click the Add button.

9.

The default permission is Read. To give Write access,
click the down-arrow next to Read and select Write.
Make sure the Everyone group’s permission is None.

1.

Display the page in edit mode, and click the CE button to
open the SiteBuilder editor.

2.

Click the Access Control tab, and locate the Search field
at the bottom of the page.

3.

Type the user ID or name of the person to whom you
want to give access, and click Search.

4.

When the name is displayed, click the person’s name in
the search results list to display the permissions settings
for that user.

5.

Scroll down to the Memberships section.

6.

In the Select group field, click the down arrow and select
the appropriate group for your site, usually sitereaders, where site is your site name.

Click to change
permission
10. Scroll to the bottom of the page and click the Done
button. (If your page is open to everyone, this
will be a long way down.)

To remove explicit permissions:
1.

To limit access to a page and its subpages to a
specific group of users:
1.

Enter edit mode and click the CE button.

2.

Navigate to the folder that contains the page you want
to secure, using the breadcrumbs at the top of the page,
or the folder list, if it is displayed.

3.

Click the Edit button and select Edit Permissions.

4.

Click the Set Explicit Permissions
button on the far right of the page. The Edit Permissions
page is displayed.

5.

Read the warning, and click the Create

6.

Click the Add Group

7.

In the Search for groups to add field, type part of the
group name and click the Search button. All the groups
that include those characters will be listed in the box.
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Note: You must have Administrator access to your site to
give access to someone else.

Click to add

Enter edit mode, and click the Properties tab.

a)

To give access to your edit site for reviewers:

Select the
appropriate
group for your
site

To remove explicit permissions for a specific group—on
the Edit Permissions page, click the Remove Explicit
Permissions
button next to the group you want to
remove.
Click to remove
permission for this group
Note: Removing explicit permissions for a specific
group does not return the file or folder to the default
permissions inherited from the parent folder, so any
later changes to permissions at the parent level will
not be carried down to this file or folder.

2.

button.

button.

To remove all explicit permissions for the page and
return to the permissions inherited from the parent
folder, click the Remove Explicit Permissions
button at the far right side of the
page. This will ensure that future changes to the parent
folder will be carried down to this file or folder.
Confirm the removal by clicking the Remove button.

3.

7.

Click the Save

8.

Click the Insite Editor
Insite Editor view.

button.
button to return to the

To remove access for a user:
Follow steps 1 through 5 above, click the down arrow on the
explicit membership type for your site, and then select No
membership. Save as above.
Locate your group
Select no membership

Scroll to the bottom of the page and click the Done
button.
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